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Transportコントロール 

Pyramixの機能には、再生/リバース再生を含む様々なTransportコントロールも特徴となっており、倍速（2，4，
16）設定や、ショートカット・キーへの割り当てなどのカスタマイズが行えます。また、外部リモート・コントローラー
からPyramixへTransportコマンドを送ることも可能です。 
 
ショートカット・キーの割り当てについては“Pyramixのカスタマイズ”を参照してください。 

  
  

ナビゲーション 

Pyramixには、プロジェクトをナビゲートするための多くのコマンドや方法があります。 
  
  

タイムスケール・ルーラー 

Pyramixには多くのTimeスケール・オプションが用意せれています。各Timeスケールには、Timeスケール・ルー
ラーおよびツールバーが備わっています。 
 

メインのTimeCodeルーラー 

プロジェクトの編集パネルの上段には、水平方向にTimecode情報を表示するエリアがあります。ここが、メインの
TimeCodeルーラーとなります。Timeスケール・ルーラーの左端（トラック･ヘッダー表示の上）には、現在表示し
ているタイムラインの範囲（ズームのスケール）が表示されます。 

  
プロジェクトの編集パネル上でPlayカーソルを移動する最も簡単な方法は、Timeスケール・ルーラー上の任意の
場所でマウスを左クリックします。Playカーソルは、直ちにクリックした新しいポジションへ移動するでしょう。また、
Timeスケール・ルーラーに沿ってPlayカーソルをドラッグ移動することもできます。 

  

コンテキスト・メニュー 
Timeスケール・ルーラーの左端（トラック･ヘッダー表示の上）をクリックすると、下図のコンテキスト・メニューが表
示されます。 
 

 
  

最初の5つの項目は、メインのTimeCodeルーラーの表示モード（スケール単位）を選択できます： 
z Frames 
z Samples 
z [ms] 
z CD frames 
z Display as CD Time 
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後半の残り３つの項目は、TimeCodeスケール・ルーラーに新しいTimeスケール・ルーラーを追加表示します。 
z Alternate TimeCode Scale 
z Feet Scale 
z Bars & Beats Scale 
 
 

Alternate Timeスケール・ルーラー 
Alternate TimeCode Scale選択すると、メイン・バーの下にもう一つTimeCodeスケール・ルーラーを追加できま
す。 
 
Alternate Timeスケール・ルーラーは、View > Scales / Toolbars > Alternate TimeCode Scale Settings メ
ニューを選択するか、表示されているAlternate Timeスケール・ルーラーの左端をクリックしてコンテキスト・メニュ
ーからAlternate TimeCode Scale Settingsを選択することで、スケールの設定が行えます。 

  
下図のAlternate Scale Settingsダイアログが開きます。 
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Scale Setting 

 
  
 TimeCode Resolution コンボボックスは、タイムコードの解像度の種類を選択できます。 

z Frames 
z Samples 
z [ms] 
z CD Frames 
 

 

TimeCode Resolutionを“Frames”に設定した場合、Alternate Frame Type for Frame Resolutionのコンボ
ボックスでフレームを選択できます。 
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Alternate Frame Type for Frame Resolutionを選んだ場合、Stretch Scale to match Main Scale Frames
のチェックボックスはメインの TimeCodeスケール・バーと Alternate Timeスケール・バーの表示を（1 フレーム＝
1 フレーム）に揃えます。チェックを外した状態では、（1 秒＝1 秒）で揃っています。スケールをストレッチさせて（1
フレーム＝1フレーム）にした場合、両方のスケール表示は異なりますが、例えば 24フレームのイベントと 25フレ
ームのイベントを比較することが可能です。 

  
  

Origin in Main Scale 
 
Offset 
メインの TimeCodeスケール・バーと Alternate Timeスケール・バー間で、オフセットをストアすることができます。 
例えば、同じ映像を使用してバージョン違いの音声を作成する際に使用してください。 
 
Store ボタンをクリックして現在のカーソル位置情報から自動計算させるか、Offset タイムを直接タイプ入力して設
定します。 
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Film Feetスケール・ルーラー 
他のスケール・ルーラーと同様、Feetスケール・ルーラーのヘッダー（左端）をクリックするとコンテキスト・メニュー
が開き、そこからFeet Settingsダイアログを開くことができます。 
 

 
  

Foot Type 
ラジオボタンは、16mm（40 フレーム/フィート）と 35mm（16 フレーム/フィート）を選択できます。 
 
Frame Type 
デフォルトは、All Settings > Formats & Sync > Frequenciesで設定されているフォーマット（General 
Settings Format）です。ノンリニア編集の状況によっては、他のフレーム・タイプを要するかもしれません。 
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Bars & Beatsスケール・ルーラー 
他のスケール・ルーラーと同様、Bars & Beatsスケール・ルーラーのヘッダー（左端）をクリックするとコンテキスト・
メニューが開き、そこからBars & BeatsダイアログとTempo Mapを開くことができます。Tempo Mapオプション
を選択すると、Bars & Beatsスケール・ルーラーの下に任意のテンポ・マップを表示することができます。 
 

 
  

Midi Files Import / Export 
z Load 
z Save 
 
両方のボタンは、ロードするファイルや保存先のロケーションをナビゲートするブラウザ画面が開きます。 
 
Note: 一般にタイプ2のMIDIファイルをインポートした時は、トラック1のテンポ・マップとシグネチャーしかインポー
トしません。 

  
Resolution 
PPQ（Pulses Per Quarter Note）のクロック解像度を設定します。コンボボックスから、192～49152までの値を選
択できます。 

  
Bars & Beats 

Offset メインのTimeCodeスケールとBars & Beatsスケール間で、オフセットをストアすること
ができます。Storeボタンをクリックして自動計算させるか、Offsetタイムを直接タイプ入
力して設定します。 

Store 現在のカーソル位置情報からOffsetタイムを自動計算して設定します。 
  

Note: オフセットは、ネガティブ/ポジティブに設定できます。 
  



 
 
 

Pyramixユーザーマニュアル  

 Time Signature & Bars 
画面の左下にはソングファイルのオーダーによるバーのブロックがリスト表示されます。以下の設定は、リスト内で

選択しているバーの設定を行います。 
 

Time Signature コンボボックスを使用してタイム・シグネチャー（拍子）を設定してください。 
Number of Bars コンボボックスからInfiniteを選択するか、値を直接タイプ入力してください。 
Snap Grid コンボボックスからOffを選択するか、Note～1/64 Noteの間で値を選択してください。

  
 
Add Bars 
クリックすると、リストに新しいバーのブロックが追加されます。 
 
Remove Bars 
リスト内から、任意のバーを削除します。 

  
  
  

Metronome 
 
Metronome Settings... 
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Tempo 
画面の右下にはソングファイルのオーダーによるテンポの定義がリスト表示されます。以下の設定は、リスト内で

選択しているテンポの設定を行います。 
  

BPM ドロップダウン・リストから任意のBPMを選択するか、値を直接タイプ入力してください。
右端の▲/▼ボタンを使用すると、1BPMのステップで増減できます。 

Frames & Perfs フィルム・コンポーザーによって使用されるテンポ定義の代替設定です。 
これは、24フレーム/秒，8perfs，フィルム・パーフォレーションをベースにしています。 
従って、値が24.0の場合に60BPMのテンポになります。 

Perfsは小数点も入力できますが、誤った値（例：12.7）は修正されます。 

Smoothing コンボボックスからOffを選択するか、Note～1/64 Noteの間で値を選択してください。
Start テンポのスタート・ポイントを入力することができます。 
End テンポのエンド・ポイントを入力することができます。 

  
 定義されているすべてのテンポが表示されます。 
  
  

Add Tempo 
クリックすると、リストに新しいテンポが追加されます。 
 
Remove Tempo 
リスト内から、任意のバーを削除します。 
 
 

Playカーソルのオプション 

Viewメニューを開くと、Playカーソルに関する４つのオプション・メニューがあります： 

   
 Local Options 

Fixed Cursor while playingを選択すると、再生中にPlayカーソルのポジションを画面上に固定し、タイムライン
を移動させます。ただし、Play Selectionを行う場合は、一時的にFree Cursorモードへ切り替わります。 
 
Free Cursor while playingを選択すると、再生中にPlayカーソルがタイムライン上を移動します。Playカーソル
が画面の端へ到達しても、画面をスクロールせずにタイムラインの表示を残します。 

  

Chase Options 
Free Cursor while chasingを選択すると、PyramixがチェイスしているTimeCodeマスターの機器がStop / Rew 
/ FF / Play / Locateなどを行っていても、自由にタイムライン表示を移動できます。このモードは、シネマのミックス
時などにPyramixをチェイスさせたまま、現在のTCポジションに関係なく迅速に編集・調整の作業を行うために有
効です。 
 
Free Cursor while chasingを選択していない場合、カーソルは常時TCソースとなるTimeCodeにチェイスしてい
る状態となります。PyramixのPlayカーソルとタイムラインの表示は、常に現在のTCポジションを反映します。 
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 Auto Return 
Cursor Auto-Return after playingメニューを選択すると、再生を止めた時に自動的にPlayカーソルが元の位
置（再生をスタートしたポイント）へ戻ります。 

  

Playカーソル・ポジション 
View > Fixed Cursor while playingを選択した場合、Playカーソルが画面で固定されるポジションはSettings 
> All Settings > Application > Playback/Recordページの“Fixed Cursor Settings”の設定で反映されます。
“Place of Cursor in Screen”のコンボボックスから、1/2～1/10の範囲で設定してください。 

  
  
  

カーソル&タイムスケール・ルーラーのツールバー 

Timeスケール・ルーラーの上には、タイムスケール・ツールバーとカーソル・ツールバーがあります。 
複数のTimeスケール・ルーラーを表示している場合、TimeCodeスケール・ツールバーも下図のように2行になっ
て表示されます。 

  

 
  

各ツールバーには、TimeCodeに関連するレジスターが並んで表示されています。また、各レジスターの右端には
▲/▼ボタンが表示されます。カーソル情報のカーソル・ツールバーとマーカー/リージョン情報のタイムスケール・
ツールバーは、Timeスケール・ルーラーおよびマーカー・トレイと関連しています。 
 
Alternate Time Scale，Foot Scale，Bars & Beats Scaleのツールバーは、各スケール・ルーラーを表示した際に
カーソル・ツールバーの下に並んで表示されます。 
 
これらのツールバーは、View > Scales / Toolbarsメニューでそれぞれ表示/非表示を切り替えることができます。
View > Scales / Hide All Toolbarsメニューを選択すると、すべてのツールバーの表示/非表示を切り替えること
ができます。 
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▲/▼ボタン 
各TimeCodeレジスターの右端に表示されている▲/▼ボタンボタンは、クリックする毎にレジスターの値を最小単
位で変更することができます。例：）Frame，Sampleなど（ルーラーのスケール単位の設定が反映されます） 
 

装飾キー 

 
クリック Frames 
Alt + クリック Subframes 
Ctrl + クリック Seconds 
Shift + Click Minutes 
Ctrl + Shift + クリック Hours 
Ctrl + Alt 任意のNudge値 

  
  
  

カーソル・ツールバー 

 
  

 
クリックすると、現在のPlayカーソルの位置へタイムライン表示を移動します。 
Playカーソルはタイムラインの中央に表示されます。 

 現在のPlayカーソルの位置です。レジスターをクリックすると、編集できます。 

 

 

グローバルMuteインジケーターです。 
 
消灯している場合、Muteになっているトラックはありません。 
 
点灯している場合は、トラックのどこかがMuteになっています。クリックすると、すべ
てのMuteを解除することができます。 

 

 

グローバルSoloインジケーターです。 
 
消灯している場合、Soloになっているトラックはありません。 
 
点灯している場合は、トラックのどこかがSoloになっています。クリックすると、すべ
てのSoloを解除することができます。 

 

 

ミキサーが共有の状態を示しています。 
 
消灯している場合、現在のプロジェクトのミキサーは単独で使用しており、他のプロ

ジェクトとミキサーの共有はできません。 
 
点灯している場合は、現在のプロジェクトのミキサーを他のプロジェクトと共有できま

す。詳しくは、Mixerセクションの“ミキサーの共有”のページを参照してください。 

 現在のEditモードを表示します。クリックすると下図のメニューが開きます。 
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現在設定されているEditモードのオプションにはチェックが表示されています。任意のオプションをクリックすること
で変更することができます。 

  
Auto-Ripple Auto-RippleモードをOn/Offします。InsertおよびRemoveモードによるすべてのオ

ペレーションにおいてリップル編集が適用されます。 
Overwrite チェックすると、クリップはOverwrite モード（デフォルト）によって編集されます。 

既存のクリップに他のクリップを重ねて置いた場合、重複する部分は上書きされま

す。 
Insert Track チェックすると、クリップはInsert Trackモードによって編集されます。 

トラック上にクリップをインサートすると、それ以降にあるトラック上の全てのクリップ

はインサートされたクリップの長さ分、右方向（長手方向）へ移動します。 
Remove チェックすると、クリップはRemove モード（デフォルト）によって編集されます。 

トラック上のクリップを削除した場合、その場所は無音になります。前後に置かれて

いる他のクリップの位置に影響はありません。 
Remove & Ripple チェックすると、クリップはRemove & Rippleモードによって編集されます。 

タイムライン上からクリップを削除すると、それ以降にあるトラック上の全てクリップ

は、削除されたクリップの長さ分、左方向へ繰り上がります。 

Don’t Snap Snapモードを無効（デフォルト）にします。選択したクリップをトラック上に置かれてい
る他のクリップの影響なく編集します。動作はInsert TrackおよびRemoveモードに
従います。 

Head to End このモードは、選択したクリップのHeadの位置をそのトラックの最後尾にあるクリップ
のTailへ隣接するようにSnapします。 

Tail to Beginning このモードは、選択したクリップのTailの位置をそのトラックの最前列にあるクリップ
のHeadへ隣接するようにSnapします。 

Head to Nearest このモードは、選択したクリップのHeadの位置を一番近くにある編集ポイントあるい
はマークへSnapします。この場合のマークには、Playカーソル，IN / OUTポイント，
マーカー，CDマークが含まれます。 
Insert Trackモードに設定している場合、動作は相互に作用します。 

Tail to Nearest このモードは、選択したクリップのTailの位置を一番近くにある編集ポイントあるいは
マークへSnapします。この場合のマークには、Playカーソル，IN / OUTポイント，マ
ーカー，CDマークが含まれます。 
Insert Trackモードに設定している場合、動作は相互に作用します。 

Snap to Original 
TimeCode このモードは、選択したクリップをオリジナルのTimeCode位置へSnapします。 

  
  
  



 
 
 

Pyramixユーザーマニュアル  

Note: Editモードをデフォルト以外のオプションに設定すると、Editモードの表示ラベルが赤く点灯します。 

 
  

  

その他のTimescaleルーラー・ツールバー 
 

Main（マーカー&選択レンジ）ツールバー 

 

Alternate TimeCodeルーラー・ツールバー 

 

Film Feetルーラー・ツールバー 

 
 

M IN クリックすると、現在のInマーカーの位置へタイムライン表示を移動します。 
Inマーカーはタイムラインの中央に表示されます。 

M OUT クリックすると、現在のOutマーカーの位置へタイムライン表示を移動します。 
Outマーカーはタイムラインの中央に表示されます。 

M DUR クリックすると、現在のIn/Outマーカーの範囲をズームしてタイムラインに表示しま
す。 

R IN クリックすると、現在選択されているレンジまたはセレクション範囲の先頭の位置へタ

イムライン表示を移動します。先頭の位置はタイムラインの中央に表示されます。 
R OUT クリックすると、現在選択されているレンジまたはセレクション範囲のエンドの位置へ

タイムライン表示を移動します。エンドの位置はタイムラインの中央に表示されます。

R DUR クリックすると、現在選択されているレンジまたはセレクション範囲をズームしてタイ

ムラインに表示します。 
  

M Durまたは R Durのレジスターをクリックして値を変更した際は、それぞれ Outの位置が調整されます。 
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Bars & Beatsルーラー・ツールバー 

 
  

M IN クリックすると、現在のInマーカーの位置へタイムライン表示を移動します。 
Inマーカーはタイムラインの中央に表示されます。 

M OUT クリックすると、現在のOutマーカーの位置へタイムライン表示を移動します。 
Outマーカーはタイムラインの中央に表示されます。 

M DUR クリックすると、現在のIn/Outマーカーの範囲をズームしてタイムラインに表示しま
す。 

R IN クリックすると、現在選択されているレンジまたはセレクション範囲の先頭の位置へタ

イムライン表示を移動します。先頭の位置はタイムラインの中央に表示されます。 
R OUT クリックすると、現在選択されているレンジまたはセレクション範囲のエンドの位置へ

タイムライン表示を移動します。エンドの位置はタイムラインの中央に表示されます。

R DUR クリックすると、現在選択されているレンジまたはセレクション範囲をズームしてタイ

ムラインに表示します。 
  

M DurまたはR Durのレジスターをクリックして値を変更した際は、それぞれOutの位置が調整されます。 
 
 

START STARTレジスターは、初めの小節のオフセット入力を有効にします。 
METRO クリックするとMetronome Settingsダイアログを開きます。 

ラベルの右側をクリックすると、On，Pre-Roll（のみ），Offが切り替わります。 
Volume METROラベルの下のボリュームスライダーは、メトロノームのクリックレベルを設定

できます。 
BPM BPMを表示します。クリックすると変更することができます。 
SG タイム・シグネチャー（拍子）を切り替えます。 
4/4 タイム・シグネチャー（拍子）を表示します。クリックすると変更することができます。 
PRL プリロール値を表示します。クリックすると変更することができます。 
CLK IN Click Inを設定（1,1,1以外の値）した場合、Click InのBar/Beatにプリカウントしま

す。それ以外場合は、初めの小節のプリカウントをします。 
Lock (chain) Symbol 記号をクリックすると、空白（Off），MRK（Inマーカー），RGN（リージョン）が切り替わ

ります。マーカーまたは選択したリージョンにCLK IN / OUTをリンクさせることができ
ます。 

CLK OUT Click Outを設定（1,1,1以外の値）した場合、Click OutのBar/Beatにポストロール・
カウントします。それ以外場合は、初めの小節のプリカウントをします。 
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マーカー 

Pyramixには様々な種類のマーカーがあり、設定したマーカーはタイムライン上のマーカー・トレイに表示されます。
そのうち、CD&SACDマーカーについては、CD/SACDマスタリングの“CDマーカー”のページを参照してくださ
い。 

  

 
 
マーカーの機能は、Cursor & Markersメニュー，ツールバー，ショートカットから利用することができます。 
Cursor & Markersメニューの内容については、“メニュー：Cursors & Marks”のページを参照してください。 
 

マーカーのリネームと削除 

任意のマーカーにカーソルを合わせて右クリックメニューを表示します。Rename MarkerまたはDelete Markerメ
ニューが選択できます。 
 

マーカーへのロケート 
トラック・ヘッダーの上（マーカー・トレイの一番左）をクリックすると、現在設定されているマーカーのリストが表示さ

れます。任意のマーカーをクリック選択すると、Playカーソルがロケートします。 
 
 
 

Markersタブ画面 

マーカーの追加や管理は、Markersタブ画面から行うことができます。 
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最大48個までのマーカーが、ショートカットやコントローラーにアサインできます。Markersタブ画面内のProject 
Markersまたは任意のTrack Groupを指定することで、マーカー・リストの表示を切り替えて編集できます。 
マーカーはタイムラインの時間に従って昇順に付番されます。マーカーを他のマーカーの前後へ移動した場合は、

関連するマーカーの番号が自動的に変更されます。 
  

新しいマーカーを追加するには、1行目のフィールドにある‘Click here to add a new Marker’をクリックして、マ
ークの名前を入力します。追加されたマーカーは、00:00:00:00で登録されるので、Timeフィールドを使って値を
編集してください。 

  
  

マーカーの色はユーザー指定できます。Colorフィールドのドロップダウン・リストから色を選んでください。 
  

マーカーの名前が表示されているフィールドをダブルクリックすると、Playカーソルがマーカーの位置へジャンプし
ます。 

  
Ctrlキーを押しながらをダブルクリックすると、マーカーのTimeCodeから再生します。 

  
Shiftキーを押しながらをダブルクリックすると、マーカーのTimeCodeからプリロール再生します。 
 
また、リスト内のマーカーを右クリックすると、マーカーのCut / Copy / Pasteが行えます。 

  
  

マーカーのリンク 
Markersタブ画面内の一番上にMarkers Linkingのドロップダウン・リストがあります。 

 
 
ここでは、トラックを編集した場合にマーカーをどのように連動させるかを設定します。 

  
Markers Independent  マーカーはTimeスケールにロックします。 
Linked to Any Track  マーカーはトラックとリンクします。 
Linked to Tracks without Group マーカーはグループに属していないトラックとリンクします。 
Linked to ‘Effects’, ‘Music’, ‘Foley’ マーカーはリスト内の指定したTrackグループとリンクします。 
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Jog & Shuttle 

マウスのホイールを使ったスクラブ 
Timeスケール・エリアにおいて、Playカーソルをマウスのホイールで掴んで前後へ動かすとオーディオをスクラブ
することができます。スクラブの再生スピードは、画面のズームの状況で相対的に変化します。マウスのホイール

を離すとスクラブ動作は停止します。 
 

Shuttle 
最大８倍速のスピードでオーディオを出力しながらシャトルできます。 
 
 

Jogホイールの設定 

Jog Wheel Mode  
Jogホイールのモードは、Machines > Controllersのサブメニューから選択できます。 
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Jog Wheel Settings 
Jog / Scrubのパラメーターは、Settings > All Settings > Application > Jog / Chaseページで行います。 

  
Auto Jog on move 
フィジカル・コントローラーのJog / Shuttleホイールを使用する場合にチェックしておくと、Jogホイールを回したこと
を感知して自動的にJogモードになります。 
 
Geared Jogging 
チェックすると、Jogモードの“gearing”を有効にします。JogホイールをタイムラインのZoomサイズに合わせて移
動することができます。 

  
Jog Speed ceiling 
4つのラジオボタンで、JOGの最大スピードを 1X，2X，4X，8X から選べます。 
 
Flywheel responsiveness and Inertia  
Jog動作への反応を、オーディオを可能な限り滑らかにする（Smooth）と、ポジションを正確に示す（Responsive）の
間で最適化するパラメーターです。Smoothにすると、Jogを回した時に再生される音はスムーズですが、反応速度は遅
くなります。スライダーを完全にResponsiveにした場合、Smoothingフィルターはかかりません。 
ポストプロダクションなどの用途ではビデオとのタイトなシンクが必要となるため、Responsive方向に調整します。 
まずは、中間の位置からスライダーの設定を開始してみてください。 
 
Jog - sensitivity [0.33] second(s) per revolution 
フィジカル・コントローラーのJogホイールを1回転させた時に何second（秒）動かすかを値で入力します。 

  
Shuttle - sensitivity [2] revolution(s) for nominal speed 
Jogホイールを回転させた時に、どのくらいの回転数でShuttleスピードを上げるかを調整します。 
例： [ 2 ]を入力すると2回転，[ 0.25 ]を入力すると1/4回転させる必要があります。 
 
Navigate - sensitivity [3] revolution(s) to traverse the timeline 
サイレントJogモードです。Jogホイールを回転させた時に、どのくらいの回転数でタイムライン上を移動させるか調
整します。タイムラインのZoomサイズに応じて移動スピードは変化します。 
 
Geared Jog mute when timeline view range is > 00:00:10:00 
Geared Joggingを有効にした場合、Zoomサイズを設定します。タイムラインのZoomサイズが設定範囲を超えた
場合、オーディオ出力を自動的にミュートします。 
 
Fine Jog sensitivity factor [0.25] 
Machines > Controllersメニューで“Jog-Wheel - Fine”を有効にした場合に呼び出すJogホイールの感度を設
定します。任意の回転数を入力してください。 
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Mouse Scrubbing Settings 
Timeスケール・エリアにおいて、Playカーソルをマウスのホイールで掴んで前後へ動かすとオーディオをスクラブ
することができます。スクラブの再生スピードは、画面のズームの状況で相対的に変化します。マウスのホイール

を離すとスクラブ動作は停止します。 
 
設定は、Settings > All Settings > Application > Jog / Chaseページで行います。 
 
Analog Tape ModeとRepeat Loop Modeの2つのスクラブ・モードがあります。ラジオボタンで設定したいモード
の方をクリックしてください。Repeat Loop Modeに設定した場合、ループの長さはベースサンプリング周波数に
関連してきます。44.1，88.2，176.4kHzでは116ms、48，96，192kHzでは106msとなります。 
 

Analog Tape Mode アナログテープ機器のようなレスポンスでスクラブします。 
Jog anyway 選択すると、常にJogモードで動作します。 
Shuttle when more than 
10 [s] is shown 
in the Timeline 

選択すると、10秒以上のクリップがあった場合Shuttleモードで動作します。 

Repeat Loop Mode Playカーソルの位置から始まる短いループを繰り返します。 
 
 
 

Vari Speed Audio Quality 

High when playing less than of equal to [6] track(s) 
Best when playing less than or equal to [2] track(s) 

  
MassCore : 負荷の状態によって、自動的にVari speedのクォリティが設定されます。 

  
Native & Mykerinos : 任意のトラック数をボックスに入力設定します。 
 

Fast Speed Settings 
F.FWD and REW nominal speed ratio [20] 
F.FWDおよびREWのスピードを設定します。4～100倍まで入力できます。 

F.FWDおよびREWボタンを押す度に、設定した倍数まで段階的にスピードが上がります。 
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Transportコントロール 

Transportバーには、一般的に使われるトランスポート操作，チェイス，キャプチャー・オフセット，カウンターおよ
びトランスポートのステータス表示などが備わっています。 
 

 
  

カウンターは、現在のActiveマシーンの位置とTransportモードを示しています。 
 
各コントロール表示の内容は、以下のとおりです： 
 

 
カウンターはRecordモードを示しています 

 
Rewindボタンは、Activeマシーンを巻き戻します。 
2回押すと、ダブル・スピードになります。 

 
ActiveマシーンがInternal Machine（Pyramix）の時に、Play Selectionボタ
ンは、現在選択しているエリアを再生します。 

 
Playボタンは、ActiveマシーンをPlayモードにします。 

 
Recordボタンは、ActiveマシーンをRecordモードにします。 

 
Fast Forwardボタンは、Activeマシーンを早送りします。 
2回押すと、ダブル・スピードになります。 

 
再生を停止するStopボタン 
（Pause機能は、Machines > Active Machine > Pauseメニューにあります） 

 
Loopボタンは、Activeマシーンをループ再生モードにします。 
任意のMark In/Outポイントの区間を、繰り返し再生します。 

 
Shuttleコントロール・スライダーは、Play中に操作すると最大8倍速でPlayカ
ーソルを前後にシャトルすることができます。（シャトルの最大速度は、

Settings > Jog ChaseのJog Speed Ceilingの設定に依存します。） 
 
Machines > Controllersメニューの“Jog Wheel Mode – Pitch”を選択して
いる場合、最大速度は±25%で動作します。 

 
ドロップダウン・リストから制御するマシーンを選択できます。 
Internalを選択すると、Pyramixを外部デバイスから切り離して直接コントロー
ルが行えます。 
その他のマシーンの設定は、Settings > All Settings > Remote Control > 
Machineから行えます。（例：RS-422 Sony 9ピン P2制御のマシーン） 

 
Chaseトグル・ボタンをアクティブにすると、TCポートのTimeCode入力に追従
して再生ます。 

 
外部コントローラーのOnline / Offlineを切り替えるトグル・ボタンです。 
（緑＝Online，赤＝Offline）  

  
Transportバーの右隣には、デフォルトでAutomationツールバーが並んでいます。 
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Transportコントロール・パネル 
 

 
Transportコントロール・パネルのボタン押すと、下図のTransport画面が開
きます。（または[Alt+T]，View > Windows / Tools > Transportメニュー） 
Transport画面には、利用可能なマシーンのステータスやコントロールが個
別に示されます。 

 

 
  

Note: このパネルでは、Internalトランスポート（Pyramix）をはじめ、設定されているデバイス毎にTransportコン
トロールが表示されます。その下には、LTCおよびVT（VITC）のTimeCodeソースのステータス表示と外部コント
ローラーに関するコントロールが表示されています。マシーンの名前の部分をクリックすると、各表示をコンパクト

に折り畳むことができます。 
  

重要: マシーンの設定に関する詳細は、Settingsの章で“Machine”のページを参照してください。 
また、それらのTransportコントロールに関する詳細は、Machineコントロールの章で“Internal / External 
Machineパネル”のページを参照してください。 
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ズーム＆パン 

プロジェクトの編集パネルでは、水平方向にタイムスケールをズームする方法と、垂直方向にトラックの高さをズ

ームする方法の2通りがあります。 
 

Timeスケールのズーム＆パン  

Viewツールバーのアイコンは、現在のPlayカーソルを軸にしたズーム・イン/アウトを行います。 
 

 
Fit in window [Alt+1]アイコンは、選択したエリアを編集パネルの幅いっぱ
いにズームしてフィットさせます。 

 
Previous zoom [Alt+2]アイコンは、一つ前のズーム・サイズに戻します。
（水平方向のみ） 

 ズーム・イン [Alt+3] 

 ズーム・アウト [Alt+4] 

 
Altキーを押しながらマウスのクリック＆ドラッグでコンポジションのエリアを選択すると、マウスカーソルが虫眼鏡
アイコンに切り替わり、選択したエリアを編集パネルの幅いっぱいにズームしてフィットさせます。 

  
マウスのクリック＆ドラッグでは、コンポジションのエリアを選択することができます。 
 
トラック表示の下にあるスクロール・バーは、トラックの表示を左右に移動することができます。 
 

Trackスケールのズーム 

 
 
トラック表示の左下には、1, 2, 4, 8, 16 および A ボタンがあります。 
各ボタンを押すと、トラックを自動的に垂直方向へズスケーリングして、編集パネルの範囲にトラック表示をフィット

させて表示します。 
  
 ボタンの脇にあるスクロール・バーは、トラックの高さを微調整することができます。 

 
 

スクロール・ホイール 

マウスのホイールを使うと以下の操作が行えます。 
 
z Scroll   トラックの表示を垂直方向へ移動します。 
z Scroll + Ctrl  タイムラインの表示を水平方向へ移動します。 
z Scroll + Alt   タイムラインのスケールを水平方向へズームします。 
z Scroll + Shift  トラック表示の高さを変更します。 
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Overviewタブ画面 

 
 
Overviewタブ画面は、プロジェクトの編集パネルを強力かつシンプルにナビゲートします。 

  
Overviewの表示は、すべてのクリップの位置を表示して、コンポジション内の全体の概観をグラフィック表示しま
す。上図で影のように表示されているグレー色のボックスは、現在編集パネルに表示されているコンポジションの

位置とズーム範囲を示しています。クリップは、タイムライン上で指定されているクリップの背景色と同じ色で表示

されます。 
 
Overviewのどこかをクリックすると、その位置が中心となって編集パネルに表示されます。 
影のように表示されているグレー色のボックスをクリック＆ドラッグすると、ズーム範囲を保ったままでコンポジショ

ンの表示を前後に移動できます。ズーム範囲を変更したい場合は、Overviewタブ内でグレー色のボックスの端を
ドラッグすることで範囲が調整できます。 
 
また、Altキーを押しながらクリック＆ドラッグすると、コンポジションの位置とズーム範囲を指定して編集パネルに
表示させることができます。 
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